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Tutorial Introduction 
PerkinElmer would like help you to become quickly productive with this product. Before running the 
software, please take some time to review this tutorial. It is intended to provide you with an overview of 
how to get the most out of your investment and our software support organization. For information on 
specific Chromera functions, refer to the on-line help. 

There is no magic in becoming proficient with pipettes, pH meters, and precision balances.  It took 
practice and training for these tools to become valuable aids in your daily life.  Chromera is your data-
handling tool, and like any other tool in your lab, the time spent learning and practicing will make your 
experience much more productive and satisfying. 

This tutorial does not cover all of the Chromera functions.  For more training contact PerkinElmer at 1-
800-762-4000 Option 4 to hear the available training options or visit PerkinElmer on the web at 
www.perkinelmer.com. 
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About this Tutorial 

The Chromera Tutorial is designed for you to interact with Chromera to understand how to get started by 
performing basic tasks. To familiarize you with this process, the tutorial leads you through a series of 
procedures that are organized to illustrate your typical workflow.  The workflow listed below is one way 
to help you get started with Chromera for the first time: 

1. Using Chromera Manager, Configure an Instrument. 

2. Launch the main Chromera application. 

3. Investigate the Run Time Environment. 

4. Build a Method for the current instrument configuration. 

5. Import data and method information. 

6. Extract a method from imported data. 

7. Complete and optimize a method for reprocessing the imported data. 

8. Batch Reprocess the imported data. 

9. Interact with data batches in Post Run. 

10. Create a sequence using the Sequence Wizard. 

11. Create a report using the Report Wizard. 

As you read through this tutorial you will receive information, including screen captures, to illustrate the 
workflow outlined above. Again, this documentation is not comprehensive, nor is it fully detailed. Its 
purpose is only to provide a suitable overview to guide you through the software and perform some of its 
basic functions. It does contain hints and cautions as appropriate. 

After completing this tutorial you will be able to: 

 Create a method - A method is a collection of parameters that determine how Chromera 
acquires and analyzes data. 

 Optimize the method - Optimizing means adjusting method parameters to provide the best 
analysis of the raw data. 

 Reprocess stored data with that sequence - Reprocessing is the re-analysis of stored data. 

 Create a report format for printing the results of the analysis - A report format contains the 
specifications for the analysis report and some of the report’s formatting characteristics. 

 Build a sequence that utilizes the optimized method - A sequence is a collection of one or 
more rows of information that defines analysis cycles. The sequence that you create 
controls how data is acquired, analyzed, and/or reprocessed. 
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Before You Begin 

The tutorial assumes that Chromera has been installed as described in the manual Installation 
Instructions for Chromera Software Kits.  It also assumes that you know how to operate your instruments 
and that you know the basics of using Microsoft Windows. 

Checklist 

Complete the following preparations before you start the tutorial: 

 Make sure that at the Edgeport is properly connected to the instruments. 

 Turn on your printer and check the paper supply. 

 Ensure that Windows is running. 

 In the Windows Explorer, you may want to create a training directory on your local drive.  
 

Other Helpful Hints 
• Follow the directory and file name instructions carefully. 

• When you collect data, you must provide values that are appropriate for the analysis that you are 
performing and for the equipment you are using. 

• The defaults on your system may be different from what the tutorial describes or illustrates. The 
tutorial may direct you to enter or select something that is already present or selected, or where 
your instruments do not provide a choice. 

• If there are no directions for a parameter, just leave it as is. 

• When there are multiple ways to do something, the choices are listed and separated by OR. 

• Operation of Chromera is not compatible with Fast User Switching and therefore Fast User 
Switching must be turned off under User Accounts in any workstation on which Chromera will be 
run. 

Fast User Switching, is a feature of Windows XP Home Edition and Windows XP Professional (when 
it is not joined to a domain) that makes it possible to switch between users without actually logging 
off from the computer. Multiple users can share a computer and use it simultaneously, switching 
back and forth without closing the programs they are running. 

 

We are ready to begin the interactive part of the tutorial. 
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About the Chromera Manager 

Chromera Manager is the starting point for your interaction with instruments (devices) in the Chromera 
environment. More specifically in Chromera Manager… 

• Instrument Configurations are created here. 

• Overall instrument Status can be monitored here. 

• Database Management utilities are accessed here.  

• Instances of Chromera, either for instrument control or for Data Only, are launched from the 
Chromera Manager. An instance of Chromera for an HPLC cannot be started directly from 
Windows. 

• When using Chromera with the ELAN ICP-MS, the Chromera software can only be started from 
the ELAN software. 

Starting Chromera Manager 

 To open Chromera Manager; Click the Windows Start button, then click Chromera Manager. 

 
The Chromera Manager dialog appears: 
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Create an Instrument 

An instrument is actually a collection of devices (such as a pump module, a detector, or an autosampler) 
which function together as a unit (instrument). Databases are also defined as part of the instrument. 

NOTE: Before beginning, make sure the Edgeport is installed and your devices are connected as described in the 
Chromera Installation Instructions. 

To configure an instrument, follow this procedure: 

1. Click on the Configuration button  to display the initial Configuration screen. 

 

2. Click in the Name field and type a name to define the name of the Instrument. 
This name can be up to 50 characters and must be unique for this user. The Creation Date 
displayed is the creation date of this Instrument Configuration. You can also type a full Description 
of this Instrument Configuration.  

NOTE: Click the Use With ELAN checkbox if this Instrument Configuration is used when Chromera is run from 
the ELAN software. 

 

3. Click the plus button   to the left of Name to expand the entry fields so that you can enter the 
Device Names. 

4. Click in the Device Name field and select a Device Name from the drop-down list. 
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5. Click in the Port Name field and select a Port Name from the drop-down list.  
All instruments and the Fluorescence detector will have a COM port. For example if the Autosampler 
is connected to the Computer, it could be COM1. Depending on the Edgeport, COM ports could be 
labeled from COM1, COM2, etc. 

 

6. Click in the Device Description field and type a description of this device. 
Initially the User Device Name field displays a short name for the device.  This is an abbreviation 
for the device type, with a number added if more than one device of that type is present in the 
configuration.  You can modify this by typing a name (using up to 50 characters) by which the 
device will be known within the software. Each user device name must be unique within the 
instrument. This name is used (for example) in the Method Editor. 

7. If necessary, click in the Serial Number field and type the serial number of the device (using up to 
50 characters). This step is an optional. 

8. If necessary, click in the Firmware Version field and type the version number of the firmware 
installed in the device (using up to 50 characters). This step is an optional. 

9. To add another device, click in the next Device Name field and select a Device Name from the 
drop-down list. Continue to enter the information for the device. 

10. Leave the default DB Connections settings for Server, DBName, and ArchiveDB.  These settings 
will appear as the Server, DBName, and Archive Database for this instrument. 
The default DBName is Chromera. Each user can have their own database. Each instrument can 
have its own database. Instruments and/or users can share a common database. 
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11. When done, click the Save button   to save this Instrument Configuration. The 
Instrument is displayed under the user name in the Navigation Pane. 

 

About Database Management 

The following general principals apply when using a database. 

• Each instrument requires a database. 

• You can create the new database for the configuration. 

• Each person using Chromera can have their own database. Each instrument can have its own 
database. Also, instruments and/or users can share a common database. 

• Searching in a database is a database function. A database has no files; however, there are 
database records. 

• If the database already exits, a message will be displayed alerting you. Switch to the Delete tab to 
delete the existing database, if desired. 

IMPORTANT:    Once you delete a database it CANNOT be recovered. 
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Create a Database 

Before running Chromera you must create a database. To create a database, follow this procedure: 

1. Click on the Database Management button  to display the database 
screens. 
The database functions (Create, Backup, Restore, Delete, Archive, and Retrieve) are 
displayed as tabs. Click on the tab to display more detail of your desired function. The first screen 
that appears is Create. 

 
Notice that the Server name is filled in. This name corresponds to the default DB Connection 
settings that were made when you configured an Instrument in Configuration. 

2. Select one of two types of databases you want to create. Select either Method/Sequence/Result 
or Archive.  
In this example we are creating the Method/Sequence/Result database. 

3. Click the Create Database button. 
Observe the progress bar to the right of the Create Database button as the database is created. 
When the database creation is complete a message appears in the Messages box indicating this. 
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Launching Chromera 

The Chromera application is different from Chromera Manager. To launch Chromera, follow this 
procedure: 

1. Select the Instrument you want to initialize and click the Launch button … or simply double-click 
the instrument name. 
Each instrument needs to be launched in its own session. 

 

The system does extensive checking of the Chromera installation to ensure that the database is 
intact, proper program files have been installed, etc. 

 

Any normal errors or warnings encountered during startup are displayed. 

2. Once the system is running, instrument errors are displayed in the fade-in notification area, and will 
be written to the Error Log, accessible from the Chromera Tools menu.  
Unexpected errors are trapped at the OS level and recorded in the Windows Event Log under 
Application Errors.  
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3. Once Chromera has been launched, the Device Connections dialog displays showing the status of 
the connections. As the Device tries to connect, Connecting … displays in the button. 

 
If a device does not connect, click the Connect button to retry making a connection to the 
instrument module. You can display the Device Connections dialog at any time from the 
Chromera Tools menu. 
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About Working with Example Data 

This session describes how you can Import example data into Chromera and work with the Data 
Selector. We are using a specific example data file so you can familiarize yourself with the specific 
features within Chromera. 

NOTE: If you are somewhat familiar with Chromera and you have acquired your own data you may want to use 
it in place of the Example Data. 

1. Upon installation of Chromera, the Example Data are installed into in the Chromera directory as 
shown below. 

 

2. Expand the External Standard Examples directory to display the two examples. 
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Importing Chromera Data and Methods 

To import the Chromera Results file External std-method.chxb 

1. Select Import from the Tools menu then select Chromera Results… 

 

The Import Results dialog appears: 

 

2. Click the browse button  to the right of Source file name. 
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The Open dialog appears: 

 

3. Navigate to the Example Data directory. 

 

4. Double-click on the Example Data directory then double-click on the External Standard 
Examples directory. 
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5. Select External std-results.chxb, then click Open. 
The file name appears in the Select batches to import list. 

 

6. Select External stds-UTM-2 then click the Import button. 



Tutorial Part 2: Working with Example Data.  23 

 

The progress bar shows the import progress. Upon completion, the message Import of results 
successful appears in the Messages box. 

 

7. Click the Close button. 
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Using the Data Selector 

Now that data has been imported into Chromera you can open it using the Data Selector. To open 
example data file using the Data Selector follow this procedure: 

1. Click on the Post Run button  . 

The Post Run environment opens: 

 

2. Select Open Data… from the File menu. 

 

The Data Selector opens. 

 

3. Click on the plus sign  to expand the batch, then choose one or more samples from a batch. 
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The data are stored in Batches, which are, in turn, stored in groups. Use the Data Selector to 
choose data for guiding the method editing. The operation of the Data Selector is the same 
throughout the software. 

 

A Batch contains one or more Samples. Each Sample can have one or more Replicate injections. 
Each Replicate contains one or more Data Channels. For example: 

 
• Batch 

♦ Sample 
 Replicate 

• Channel 
• Channel 

 Replicate 
• Channel 
• Channel 

♦ Sample 
 Replicate 

• Channel 
• Channel 
•  

 Replicate 
• Channel 
• Channel 

4. Click in the check box to Select the External stds-UTM-2, then click the Open button. 

 
This selects all of the samples under the batch. The Post Run screen displays the Example Data. 
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About the Chromera Method 

A method contains fundamental parameters to provide unattended control of an instrument during 
acquisition, calibration, quantitation, and post run. The Method combines Instruments, data Channels, 
Peak detection, and Calibration parameters into a single entity. These appear as distinct sections in the 
Method Editor. Clicking the Method button  in the Navigation Pane displays the Method 
Identification page in the client area (center) of the screen. 

Since you are in the Method environment, the upper section of the 
Navigation Pane displays the Method name (along with the general method 
icon  ), whose contents are based on the configuration of the displayed 
method (this is the configuration of the instrument defined in Chromera 
Manager). The client area (the large area in the middle of the screen) 
displays the part of the method corresponding to the tree selection. For 
example, selecting QPump-2 displays the method parameters for the 
Quaternary Pump.   

The second level: Instruments  , Channels  , Peaks  , and 
Calibration   represent the main sections of the method and always 
appear in the Navigation pane. You can reorder these (by right-clicking on 
a selection using the Move Up/Move Down commands in the pop-up menu) 
but they will remain at the same level.  

The names displayed under each of the second level sections depends on 
the configuration of the instrument as defined in Chromera Manager. A 
name appears under Instruments for each device configured. The text 
displayed is the name you give to the device, as defined in the Chromera 
Manager’s Instrument Configuration.  

Each device that generates a data stream that is subject to peak detection will appear under Peak 
Detection and Calibration. The text displayed is the name of the channel, as defined in the Channels 
section.  Channels are used to control the type of plot on your printed report.  Only channels that can be 
integrated display under Peaks and Calibration. The part of the method displayed in the client area of the 
screen depends on the node selected in the method tree.  

Method editing consists of modifying existing method parameters. This includes a modification to the 
method name, since in Chromera the name is a method parameter like any other (the method is uniquely 
identified by a database index that is not visible to a user). After making changes and saving the method, 
the previous version of the method is replaced by the modified version. Only a single version of a method 
is saved in the database. Also, a method cannot be saved with the same name as another method in the 
Group. To create a copy of an existing method but with a different name, leaving the original method 
unchanged, use the Save As command. 
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Editing the Method Graphically 

In this part of the tutorial you will use some of the basic features of the Graphic Method Editor to: 

• Change the plot display 

• Adjust peak detection parameters 

• Create a component list 

A method contains the parameters that determine how Chromera analyzes raw data. With the Graphic 
Method Editor, you can adjust those method parameters and see the effects of the change immediately. 

Viewing the data in graphic form helps you determine if peaks are being detected correctly, if baselines 
are being placed properly, and if expected retention times and search windows for components are 
identifying peaks accurately. 

To edit a method in the Graphic Method Editor, select raw data that represents a chromatogram of the 
analysis that you want to optimize. Chromera processes the raw data with the method currently open and 
then displays the chromatogram, showing the resulting integration and peak identification. 

Selecting Data for Graphic Editing 

1. Select Edit Method Graphically from the Actions menu.  
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The Data Selector appears: 

 

2. Click in the check box to Select the External stds-UTM-2, then click the Open button. 

You can also click on the plus sign  to expand the batch, then choose one or more individual 
samples from a batch, but in this tutorial we are selecting the entire batch External stds-UTM-2. 

 
The method appears for you to edit graphically. 

 

3. Use the currently selected data to optimize the method settings for processing similar samples. 
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Setting Integration Parameters 

Chromera uses the following parameters for optimizing: 

• Bunching Factor 

• Noise Threshold (Uses decimal digits, not just integers.) 

• Area Threshold (Uses decimal digits, not just integers.) 

Setting the Bunching Factor (BF) 

1. Click in the Bunching Factor field.  

2. Hold down the Ctrl key, click and hold the left mouse button, and drag the pointer across the width 
of the narrowest peak (this is called Ctrl, click, and drag) to set the Bunching Factor for the 
method. 

 

3. The appropriate Bunching Factor value is automatically filled in. 

 

Setting the Noise Threshold (NT) and Area Threshold (AT)  

1. Clicking in the Noise or Area Threshold field.  

2. Hold down the Ctrl key click and hold the left mouse button and drag the pointer across the region 
of baseline noise (Ctrl, click, and drag) to set the Noise or Area Threshold for the method. 

3. Select a representative section of baseline to use for calculating the Noise and Area Threshold 
values for the chromatogram. 

4. The appropriate NT and AT Threshold values will be filled in automatically. 
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5. Select Reprocess Current Chromatogram from the Actions menu. 
Or select the Reprocess Current Chromatogram icon on the toolbar. 

 

6. Then select Show Results from the Actions menu to view a peak table of the newly reprocessed 
chromatogram. 
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The current peak information displays in a pop-up window that is always on top and is automatically 
updated with every new reprocessing. 

 

Entering Component Information 

To enter component information, follow this procedure: 

1. Select the Peaks in the Method tree. 

 

2. In the Component column, enter the component names for each peak in the sample. 
Auto-Complete can be used to minimize typing when entering names for components already in 
the dictionary. 

3. Click in the Retention Time field for a component. 
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4. Click within the desired peak on the chromatogram to enter the expected Retention Time for that 
peak. This value is automatically filled in. 

5. Select Update Search Windows from the Actions menu. 

 
A dialog displays for you to change the default settings for one or more components. 

 

6. When done click OK. 

7. Repeat for each component in the method. 
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Components also can be entered into the method through the Calibration section, but retention 
times and component windows still must be entered in the Peaks section. 

 

Entering Baseline Timed Events 

1. Select Peaks from the Method tree. 

2. Select any Baseline or Integration Timed Events from the list box in the Events Table, or by 
choosing them from the Toolbar.  

 
The Integration Timed Events icons appear on the Toolbar. 

3. Select the event to be added. 
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For example, select Disable Peak Detection. 

 

4. Click in the Start Time field. 

5. Ctrl, Click, and drag on the plot to indicate where the selected events should be applied.  
• If it is a single event (no ±) then click on the chromatogram where the event is to occur.  
• If it is a ± event, click on the chromatogram where you want the event to start and drag a box to 

where you want the event to end.  
The height of the box does not matter, only the beginning and end matter. 

 

 
The Start Time and End Time values for the event are automatically filled in. The actual position 
of the event is at the left edge of the event annotation marker on the plot. Timed events can be 
repositioned on screen by clicking-and-dragging the event markers on the plot. 
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Specifying Component Calibration Information 

Calibration information and calibration levels can be entered either from the Details tab or from the Set 
Up Standards tab.  Calibration information in the method can be viewed as a component-by-component 
Summary of the current calibration curves. 

The Details view shows the current calibration settings and replicate data, if any, on a component-by-
component basis. Using Set Up Standards provides a convenient way to enter calibration standard 
information on a standard-by-standard basis and to visualize each calibration standard level. 

1. Select Calibration in the Method tree. 
Calibration opens with the Detail tab selected.   

 

The component names should be automatically transferred into the Calibration table from the 
Peaks list. 

2. Click on the device under Calibration.  In this example the device is, UVDet-3 1 
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The Details appear. 

 

3. Fill in the component and calibration information as desired. 

4. Expand the component record in the Details view (in this example, ethylbenzene is expanded) to 
display the current calibration average values, as well as any individual replicate values that 
constitute those current averages.  
The Details view is a convenient way to review the current state of calibration for the components 
in the method. 
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5. Select the Set Up Standards tab to identify the calibration standards with their constituent 
components and concentrations. 

NOTE: Set Up Standards is the more convenient way for entering Calibration Standards. 

 

6. Enter any number of calibration levels by using a right mouse click through the Add a Standard 
command on the context menu. 
Context menu selections provide convenient editing functions to fill in the Standards table. 

7. Change other calibration settings for the components in the method as required. 

8. Save the changes to the current method or select Save Method As to create a new method with 
the current settings. 

 

9. Give a new name to the method and assign it to a Group. 
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Using the Report Format Wizard 

Use the Report Format Wizard tool to create single sample or summary reports, method printouts, 
calibration printouts, or sequence printouts. The wizard is the only mechanism to create report templates 
in Chromera. There is no Report Editor as there is a Sequence Editor with Sequence Wizard. 

To create a new report format using the Report Format Wizard: 

1. Select the Report Format Wizard from the Tools menu. 

 

The Initialize Report Format Wizard screen appears. 

 

2. Under Select startup option select Create a new report format then click OK. 
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The Report Type screen appears: 

 

3. Select a Report Type from the drop-down list. 

 
You can create Sample, Summary, Calibration, Sequence, or Method reports. 

4. Click Sample to display a gallery of report styles showing the possible layouts for the report type 
selected. 
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The gallery styles available are narrowed-down based upon the selections for the type of data to be 
reported. A Sample Report can include the data and plot from one or more replicate injections and 
one or more data channels. 

5. From the Single or replicate injections drop-down list select Single Injection. 

6. Then from the Single or multiple data channels drop-down list select Single Channel. 

7. Click on a Report Format from the two displayed. 

 

8. Click Next to display the Page Setup screen. 

 

9. Select the paper size, margin settings, and page Orientation.  
The units will change based upon the paper size selected. 
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10. Click Next to display the Page Header/Footer screen. 
Each page can have a 3-section Header at the top and a 3-section Footer at the bottom. 

 

11. From each drop-down list select the information to be displayed in the left, right, and center 
sections of the Header and Footer, if desired. 

12. Select or deselect the check box if the Header and/or Footer should be displayed on the first page. 

13. Click Next to display the report Title screen. 

 

14. Select if you want a report Title printed on every page or just the first page.  
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15. You can add a Logo image to the report. Any valid graphic file type can be selected. The image can 
either be embedded within the report template, or loaded from disk and rendered each time the 
report is printed. You can also add an optional Border drawn around the Title. 

16. Click Next to display the Data Header screen. 

 

17. Select items from the Available Data Items list. Position the items in the Data Header Layout 
box by click-and-drag. The Data Header can be constructed from available sample information. 

18. Click Next to display the Plot Options screen. 

 
Since a report can consist of one or more sample replicates and/or one or more data channels, then 
one or more Plots can be displayed as well. The Plot Options entry will determine how many can 
be drawn across a page. 

19. Select if you want to include the plots in the report and enter the size of each plot. 
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20. Click Next to display the Peak Table screen. 

 
The Peak Table is where the results for each injection will be displayed. 

21. Select the desired Data Items for reporting. 
The selection of items for reporting will change based upon the type of report to be printed. The 
Available Data Items include system suitable parameters that can be calculated without required 
user input. 

22. Select to format the Numeric values with fixed decimal digits or as significant figures. 

23. Click Next to display the Signatures screen. 

 
Two different Signature lines can be displayed for hand-written signatures and timestamps. 

24. Click Next to display the Finish screen. 
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25. Enter a Report Name, Group name, and Description for this report. 

26. Click Preview to display a visual rendering of the report using mock data and graphics.  

  
This is an example of the print Preview for the completed report. The preview contains only mock 
data and plots, but the layout of the report should be as specified through the wizard. 

You have completed Part 3 of the Chromera tutorial. 
NOTE:  Every step in the rest of the tutorial is built on, and is a continuation of, the previous step. Therefore, you 

need to complete it as a whole. 
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Tutorial Part 4: Viewing Results 
and Reprocessing Data 
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Viewing Results in Post Run  

Whether reprocessing existing data or acquiring new data, the completed samples will be displayed in the 
Post Run environment, and can be inspected by navigating through the Sample Tree and interacting 
graphically with the chromatographic display.  

• Data can be treated as view only from the standard Post Run display. 

• Individual results can be optimized graphically. 

• The current version of the method can be graphically modified (GME, Graphic Method Editing) using 
the selected sample data.  

• Data can be viewed in Single Plot mode, Stacked Plot mode, Matrix mode for multiple channels 
and replicate injections, or in Overlay and 3D mode. 

To view results in Post Run: 

1. Click the Post Run button in the navigation pane. 

2. Select Open Data from the File menu. 

 
The Data Selector opens. 
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3. Select the Batch listed in the Data Selector you want to open. 
A Batch in Chromera consists of the entire collection of data and metadata used to produce a set of 
results. A batch may represent a single injection of a sample on a single detector instrument, or it 
may represent many samples, with many replicate injections, on an instrument with multiple 
detectors and multiple data channels. The creation of a batch is directed by a sequence.  
A batch contains: 

• All the sample identification specified in the sequence. 

• All the original raw data points generated from that sequence. 

• All the original method settings used to control the instrument and acquire the original raw 
data. (When possible.) 

• The current and complete set of integration parameters used to generate the current set of 
peaks. 

• The current and complete set of calibration information used to generate the current set of 
results. 

• All the results generated from the processing of the raw data using these “embedded” 
method parameters.  

Data acquired from the Sequence mode in Run Time will be written to a new batch containing all 
the data from all the injections made from that sequence. 
Data acquired from Single Injection mode in Run Time will cause a new record to be written to a 
new batch created by Chromera, containing all the data from each injection made, until the current 
Run Time mode is changed. 

NOTE: When TotalChrom data are imported into Chromera, a new batch is automatically created, containing the 
raw data and sample information from the TotalChrom RAW files, and as much of the TotalChrom 
Instrument Method as possible. Since results are not imported from TotalChrom, the imported batch will 
not contain any peak information.   

If data are processed more than once, the new results may be either appended to the existing 
batch, or written to a new sequence containing all of the information described above. The choice is 
driven by the nature of the selections and changes made in the Reprocessing environment. 
Results are never overwritten or modified in a batch. New results are just appended to the data in 
the existing batch. Open the desired Batch of data to view through the Data Selector. 

♦ A database search query can be constructed to refine the selection of data. 

♦ Searches can be saved and recalled for convenient retrieval of data fitting routine criteria. 

4. Click Open. 
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Modes of Operation 

In the Post Run environment depending upon the mode selected, you take one of three actions from 
the Actions menu. You can either view data without changing anything (Standard Post Run Display), 
optimize the integration of individual injections (Peak Identification review), or optimize the current 
version of the method in the database using one of the injections as an example (Go to Graphic 
Method Editor). 

 

Peak Identification Review 

The Peak Identification Review allows optimization of the currently selected chromatogram, by permitting 
changes to the integration parameters for that channel data, and that channel data only, thereby 
generating potentially new results for that data. These results are appended to the same batch. 

Go to Graphic Method Editor 

This functions the same as Graphic Method Editor, but only for the data on that Channel.  It launches the 
method editor for current version of the method from the database, and displays the currently selected 
data in Graphic Method Edit (GME) mode. This action leaves the Post Run mode and automatically 
loads into the Method Editor the current version of the method for the selected channel data. 
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General Views of Plot Displays 

Navigate through the Sample Tree in the Navigation Bar to select the Channel Data and Sample 
Replicate to view. The plot mode will display one or more chromatograms at a time. The results for the 
currently selected Data Channel will be displayed in the lower frame. Plot Options control the display of 
annotations, peak information, peak fills, etc.  

Single Plot 

To display a single plot: 

1. Select Single Plot from the General Views. 

2. View the chromatogram for each Data Channel one-at-a-time. 
In this example, UVDet-3 1:1, RIDet-4 1:1, Pump Pressure:1, etc. 

3. Navigate through the Sample Tree or scroll through the plots. 

 

4. You can optionally display a Radar Window from the Display menu. The Radar Plot indicates the 
localized region of the main plot that is currently in view. 
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5. Clicking-and-dragging in the Radar Window will display that selected region of the chromatogram 
in the main plot. 

6. Zoom and un-zoom using click-and-drag and selections from the context menus. 

 

7. Expand the size of the chromatogram frame either by dragging the splitter between it and the 
Results frame, or by double-clicking on the Title Bar for the chromatogram. 
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Stacked Plots 

Stacked plots enable you to view more than one plot at a time in a single column. To display stacked 
plots: 

1. Select Stacked Plots from the General Views. 

2. Navigate through the Sample tree or scroll through the stacked plots. 

 

3. The number of chromatograms to display and the order of scrolling through Replicates and Channels 
can be controlled by selecting Plot Layout from the Display menu. 
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Matrix 

The Matrix mode allows multiple Data Channels or Replicates to be shown simultaneously for each 
Sample. To display a plot matrix: 

1. Select Matrix from the General Views. 

 

2. Selecting the Matrix Layout Options control enables you to display and navigate through the 
Layers of Samples and Replicate Injections and Data Channels. 
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Overlay 

The Overlay mode allows up to 30 individual chromatograms to be displayed in the same plot window. 
Use Plot Options to control the colors to be assigned to each of the chromatograms. You can select 
specific plots to be displayed or not displayed can be selected from the Sample Tree. 

To overlay plots: 

1. Check and uncheck the data items to overlay. 
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3-D Display 

When in Overlay mode, you can enable the 3-D mode. Use the horizontal and vertical scroll bars to 
rotate the plots around the X, Y, and Z axes. You must be in the Overlay mode to undo the 3-D mode. 

To display plots in a 3-D display: 

1. Select 3-D from the Display menu. 

 

2. Double-click on the 3-D plot to start or stop auto-rotation. 
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Reprocessing the Data 

Once you have acquired data and stored it in a raw data file, you can process that data repeatedly. The 
Batch Reprocessing function enables you to reprocess a large number of files in succession. 

One of the purposes of reprocessing data is to re-analyze the raw data files listed in a sequence. For our 
last exercise, we will use the sequence file we just created to reprocess data files with our optimized 
method. 

To reprocess files in a sequence: 

1. Click the Reprocess button in the Navigation pane. 

 

NOTE: If you selected the Batch Reprocessing function when you had a sequence open, that sequence is 
supplied as the default. The Reprocess environment consolidates all the controls needed to selectively 
reprocess a batch of data. 

2. Select Open Data… from the File menu to use the Data Selector to open a Batch of data to 
reprocess. New Searches or saved Searches can be used to refine the criteria for retrieving data 
from the database. 

 

3. Click in the Select checkbox to select the batch, then click Open. 
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The screen is populated with the data to be reprocessed. 

 

The amount of processing to be performed is controlled by using the processing Slider Bar. 

 

4. Select the method version from the drop-down list to use for processing. This is disabled when the 
batch is being processed.  Options available are: 

Use Latest Stored Version of Method: The current version of the method specified in the 
sample row is read from the method database and used for reprocessing.  
The starting point for reprocessing is automatically set to Quantitation, because Peak 
Detection, Peak ID, and Calibration information will be used from the existing results. 

Use Method Saved with Results: The version of the method saved with the results are used 
for processing (processing must start with Quantify or later – see below). 

NOTE: Rows in which a new method name is selected will always be processed with the current version of that 
method. 
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When selecting a different method for processing, a new batch will be created using either the 
Name of your choice, or the same name as the existing batch but with the timestamp of the 
reprocessing. 

5. Select from the drop-down, one or more of the Data Channels to be reprocessed. 

 
Changing any information in the sequence will cause a new batch to be created using either the 
Name of your choice, or the same name as the existing batch but with the timestamp of the 
reprocessing.  

 

6. Set desired Decision Points between samples and injections to automatically pause the Batch to 
allow manual review of the data, calibration, or peak detection. 

 

7. If report templates have been created for different Sample Types, Per Sample Reports can be 
generated on a Sample Type basis. 
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8. Use the controls on the toolbar to Start and Stop the batch processing as desired. 

 

9. Select the Results tab to view the data as they being generated. 
No quantitated results are shown for the analysis of calibration standards. 
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10. The data are automatically loaded into the Post Run environment for either review or optimization. 
Now we are ready to use this sequence with the Batch Reprocessing function. 

The next section describes how to set up and run a simple sample analysis 

 

 

 



 

Tutorial Part 5: Running a 
Simple Analysis 
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Overview 
In this part of the tutorial you will:  

• Configure an Instrument (pump, autosampler, detector, oven) in Chromera Manager 

• Create and save a Method 

• Run the Method in Single Run Mode 

• Acquire data 

• Create and save a Sequence Mode 

• Run the Sequence 

Prepare Your System 

Prepare your system for this tutorial with the solvents (mobile phase), column, and sample for 
you’re your analysis. 

• LC grade methanol and water.  Reservoir A = Water; Reservoir B = Methanol 

• Universal Test Mix (P/N 00890893, 5 vial pack) 

• 3x3 CR C18 column (P/N 02580195) and column holder (P/N 07150028) 
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Creating an Instrument and Database in Chromera Manager 
This example briefly describes how to configure an instrument to run a simple analysis.  In this 
tutorial example the instrument consists of a Series 200 Quaternary Pump, Series 200 Autosampler, 
Flexar UHPLC detector, and Series 200 Column Oven.  For more details refer to Create an 
Instrument on page 10. 

Create an Instrument 
To create an instrument, follow this procedure: 

1. Click on the Configuration button  to display the initial Configuration 

screen. 

2. Click in the Name field and type a name to define the name of the Instrument (for example 
LC Tutorial). 

3. Click the plus button   to the left of Name to expand the entry fields so that you can enter 
each of the Device Names to make the instrument. Click in the Device Name field and 
select a Device Name from the drop-down list. 

4. Click in the Port Name field and select a Port Name from the drop-down list.  

5. In this example we are not going to enter a Device Description, Serial Number or 
Firmware Version. 

6. To add another device, click in the next Device Name field and select a Device Name from 
the drop-down list. Continue to enter the information for the device. 

7. Set the DB Connections settings. Leave the Server setting but change the DBName to 
Tutorial, and ArchiveDB to TutorialArchive. Each instrument can have its own database.  

8. When done, click the Save button   to save this Instrument Configuration. The 
Instrument is displayed under the user name in the Navigation Pane. 
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Create a Database 

Before running Chromera you must create a database. To create a database, follow this procedure: 

1. Click on the Database Management button  to display the database 
screens. 
The database functions (Create, Backup, Restore, Delete, Archive, and Retrieve) are 
displayed as tabs. Click on the tab to display more detail of your desired function. In this 
tutorial click the first tab to Create a database. 

 
Notice that the Server name is filled in. This name corresponds to the default DB 
Connection settings that were made when you configured an Instrument. 

2. In this example we are creating the Method/Sequence/Result database. 

3. Click the Create Database button. 
Observe the progress bar to the right of the Create Database button as the database is 
created. When the database creation is complete a message appears in the Messages box 
indicating this. 
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Launch Chromera 

The Chromera application is a separate application from Chromera Manager and must be launched 
(started). To launch Chromera, follow this procedure: 

1. Select the Instrument you want to initialize and click the Launch button … or simply 
double-click the instrument name. 

 

The system does extensive checking of the Chromera installation to ensure that the database 
is intact, proper program files have been installed, etc. 

 

Any normal errors or warnings encountered during startup are displayed. 

2. Once the system is running, instrument errors are displayed in the fade-in notification area, 
and will be written to the Error Log, accessible from the Chromera Tools menu.  
Unexpected errors are trapped at the OS level and recorded in the Windows Event Log under 
Application Errors.  

 

3. Once Chromera has been launched, the Device Connections dialog displays showing the 
status of the connections. As the Device tries to connect, Connecting … displays in the button. 
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If a device does not connect, click the Connect button to retry making a connection to the 
instrument module. You can display the Device Connections dialog at any time from the 
Chromera Tools menu. 
After all Device Connections are made Chromera displays in the Run Time mode. 
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Using Run Time 
The Run Time mode allows you to collect data without developing a comprehensive method. You 
enter only the parameters that are essential for performing a run. This is helpful when you are first 
starting to use Chromera; for example, if you are performing a survey run on a type of sample that 
you have not analyzed before or when you are developing instrument settings for an analysis. 

In this tutorial we will create a simple Method to use in Single Run mode. We will later use this 
method when we build a sequence.  Before creating a method lets set initial conditions using the 
Manual Control Mode. 

Manual Control Mode 
Use Manual Control to directly set initial conditions for system startup, equilibration, and detector 
monitoring. Here you will purge the pump, set the initial conditions and equilibrate the system, 
flush the autosampler, and verify that the detector is properly working. This is essentially the Direct 
Control mode of the software. 

 Select the Manual Control mode. 

 

Purge the Pump 

You need to purge the pump to remove any trapped air from the solvent lines and fill the lines 
from the solvent reservoirs to the pump with the selected mobile phase. 

1. Make sure the pump solvent inlet lines are in Reservoir A: Water and Reservoir B: 
Methanol. 

2. Locate the Prime/Purge valve on the front of your pump.  
You will have to either open the pump door on a Series 200 pump or on a Flexar pump 
remove the front cover. 

3. Attach the 30ml priming syringe to the Prime/Purge valve on the pump. 

4. On the Purge Pump settings, type 10 for the Flow Rate and click in the 100% A checkbox. 
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5. Open the Prime/Purge valve by turning it counterclockwise. 

6. Click Apply to start the pump. 

7. Collect about 25 to 30 mL in the syringe then click Stop LC Pump in the Control Panel. 

 

8. Close the Prime/Purge valve by turning it clockwise, then remove and empty the syringe. 

9. Attach the 30ml priming syringe to the Prime/Purge valve on the pump. 

10. On the Purge Pump settings, click in the 100% B checkbox. 

11. Open the Prime/Purge valve by turning it counterclockwise. 

12. Click the Apply button to start the pump. 

13. Collect about 25 to 30 mL in the syringe then click Stop LC Pump in the Control Panel. 

14. Close the Prime/Purge valve by turning it clockwise, the remove and empty the syringe. 

Equilibrate the System 

Equilibrate the system with your mobile phase concentration to provide a stable analysis. 

1. On the Pump Settings, type 2 for the Flow Rate, 30 for %A (Water) and 70 for %B 
(Methanol). 

 

2. Click the Apply button to start the pump with these settings.  
Let the system equilibrate for 10 minutes. 

Flush the Autosampler 
While the system is equilibrating, flush the autosampler. 

 Click the Apply button to flush the autosampler. 

 
The autosampler will flush using the displayed Flush Volume and the Number of Flush 
Cycles. In this example, it will flush 1000 µL two times. 
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Verify that the Detector is Working 

1. While the system is equilibrating, change the wavelength to 260 nm then click the Apply 
button. 

 

The baseline should change on the display. 

 

Create a New Method 

While the system is equilibrating, create a method to be used with your analysis. 

To create a new method for the current instrument configuration: 

1. Click the Method button to select the method environment. Then select New Method from 
the File menu. 
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2. Type a Method Name, Group name, Description, and Notes. 

The Group name is like a folder, and is a required field; whereas Description and 
Notes are optional.   

In this example the Method Name is Tutorial, the Group is Chromera Tutorial, and the 
Description is UTM. 

 
The Method Tree (in the Method pane on the left) provides access to all the instrument 
settings or to each module separately. 

3. Click Instruments in the Method pane to display the devices and their parameters. Enter the 
required HPLC parameters. 

 
This example has a quaternary pump configured for this Instrument in Chromera Manager. 

4. Click S200 Quat and observe that just the parameters for the Quaternary Pump display. 
Click the plus sign  to display all of the pump parameters. 

 

5. Click in the Step field and enter the parameters for this step, Step 0. 
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When done, click in the field under Step 0 and enter the parameters for Step 1.  Leave the 
rest of the parameter as the default parameters. 

 

6. Click FXUVUHPDet-3 and observe that just the parameters for the FXUVUHPDet-3 display. 
Click the plus sign  to display all of the pump parameters. 

 

7. After entering all of the parameters for all of the devices, select Save Method or Save 
Method As …. from the File menu. 
You may see a message similar to the following: 

 
Click Yes and the method will be updated. 

8. Click Instruments and view your entire method. 
Click each plus sign  to display all of the parameters. 
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Running the Method in the Single Run Mode 

To run the method, go to Run Time and make the method you just saved your Active method. 

1. Click the Run Time button, then select the Single Run Control Mode. 

 
Now you need to open the method you saved. 

2. Select Open Method from the File menu. 
The Data Selector – Single Method displays. Click the plus sign  to display the available 
methods.  This example shows on one method – Tutorial. 

 

3. Click in the Select box to the left of the Tutorial method, then click Open. 
The Method appears as a Not Active method: 
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4. Click Apply to activate your method. 

 
An Active Method is the method currently in control of the instrument and can be edited or 
modified as required while it is running. 

• Any step of the method not yet begun can be changed. 

• Any processing or calibration change can be made. 

• Apply the changes to the method without saving them.  

• Save the method and have the changes apply to all subsequent injections. 

5. Click Autozero in the Control Panel. 

6. Click the Syringe button    to start the method run. 
The Autosampler starts to inject and the display a Real-Time Plot. The Real-Time Plot lets you 
view a plot of the data as it is being acquired by an interface.  It autoscales to the largest 
peak. 

 

When running in Single Run every run creates a new batch as each injection becomes a separate 
entry in a Chromera Batch. Each injection is saved with its complete method, the raw data, and any 
results generated.  

For most labs the proper way to run Chromera is through a Sequence.  Now lets build a simple 
sequence. 
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Building a Sequence 

Sequences are used to control acquisition and analysis of chromatographic data produced by a 
series of injections. Use the Sequence Wizard to create a sequence for running new samples and 
acquiring data. It is also possible to create sequences through the Sequence Editor. 

Using the Sequence Wizard 

1. From the Tools menu select the Sequence Wizard to create a new sequence to acquire 
new data with the new method. 

2. Enter a Sequence Name, Group name and select your desired Method. 
In this example, the method is Tutorial. 

 

3. Click Next. 
The Autosampler screen displays. 

  
The Tray Type selection is restricted to those available for the currently configured 
autosampler. 
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4. Click Next. 
The Blanks screen displays. 

 

5. Since you will not be using a Blank, click Next. 
The Calibration Standards screen displays.  

 

6. Since you will not be using a calibration standard, click Next. 
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The Samples screen displays. 

 
You can apply a naming convention to sample naming if desired. If you entered a Prefix: 
Tutorial; Leading Zeroes: 2; Number:1 and a Suffix: PKI you would create sample names 
in the series of: 

• Tutorial001PKI 

• Tutorial002PKI 

• Tutorial003PKI 

• etc. 

7. Be mindful to select to View sequence in Editor or in Run Time. Otherwise, it will be created, 
and saved in the database, but you won’t see it until you choose to explicitly open it. 
This example suggests to View the sequence in Run Time. 

 

8. When done click Finish. 
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Editing Your Sequence 

When sequences are created through the Sequence Wizard, they can be automatically opened in 
the Sequence Editor when the wizard completes. Also, if your prefer, new sequences can be 
created directly from within the Sequence Editor, and existing sequences can be modified. 

The editing functions here are the same as those in the Sequence mode of Run Time, except 
that the sequence shown in this example is an Active sequence. 

The Sequence Editor has a fly-out Editing Tools menu containing editing commands. 

 

Decision Points can be set between each row of sequence. They allow the sequence to be 
paused for a user to perform manual data review: 

• Review calibration injections and data. 

• Inspect and adjust integration parameters for the active method. 
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Running a Sequence 

The Active Sequence currently controls the instrument, and can be edited or modified as 
required while it is running. Any row not yet completed can be edited and the changes will be 
applied, simply by clicking the Apply button. Starting and Ending rows for acquisition can be 
selected from the sequence. Rows that are de-selected will be grayed-out. 

1. Click the Run Time button, then select the Sequence Control Mode. 

 

2. You can use the controls on the Sequence toolbar (mid screen) to Start , Pause , or 
Stop  the sequence as desired. 

You can also select the Display the Method  icon to view and/or modify the Active 
Method currently associated with the sequence. 

 

3. Click Start  to start the sequence. 
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The sequence starts Running and the current row is highlighted green. 

4. When complete the sequence stops and remains Idle. 

 

 

Congratulations! 
You have successfully completed the Chromera Tutorial. 

This tutorial was designed to give new users a brief overview of how to setup and explore the main 
feature of the Chromera software. There are many different features and options available in 
Chromera that were not discussed in this tutorial. We strongly recommend that all users read the 
Chromera User’s Guide and the on-line Help carefully in order to fully understand this application 
and how it works.  

New users should consider attending a Chromera training class to supplement this tutorial. To find 
out more information about a training class in your area, please contact 1-800-762-4000 Option 4 
or visit PerkinElmer on the web at http://www.perkinelmer.com/Training. 

http://www.perkinelmer.com/Training


 

What If I Have Problems? 
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Try This First 

Troubleshooting system and software problems can be a real challenge to users who have extensive 
experience in computer systems, networks, and communications.  For those of us who have much less 
experience, and just want to get our samples out the door, the complexity and proliferation of 
computerized data handling systems and software may seem a bit overwhelming. 

The basics of what to do when a problem occurs are pretty much the same.  Approaching a system 
problem methodically BEFORE contacting software support or service personnel can save you time and 
money.  For example, start by answering the following questions: 

 Does your system at least meet the MINIMUM requirements as stated in the Chromera 
Release Notes? 
If it does not, you WILL have problems.  These truly are the basic requirements for the version of 
software. 

 Did you check the documentation? 
Check the section of your documentation that explains the commands and procedures you are using 
to make sure you are operating the software correctly.  It may be that what you are trying to do 
simply cannot be done, or perhaps the feature you are thinking of is actually located in another 
module of the software.  
Do not forget the HELP files (by pressing the F1 key) right at your fingertips, as well as the Release 
Notes and Known Bugs files available from your Chromera program group.  These files contain last 
minute information we received from our beta testers after manuals were printed.  Your question 
and its resolution may be right here. 

 Have you performed good housekeeping procedures on your system? 
Users with MIS staffs overseeing their system needs probably have established system 
housekeeping procedures.  However, if you also pull double duty as the keeper of your computer, 
you will need to perform weekly maintenance.  This includes disk defragmentation, file backup, and 
removal of any files you no longer need (for example; error log files).  Data acquisition systems such 
as Chromera are incredibly disk intensive, so the cleaner your hard drive, the faster your system.  
Also check your system’s TEMP directory to make sure it’s not cluttered with  .TMP files you no 
longer need.  Use a general diagnostics utility once each month to check all other components of 
the system for signs of failure.  Do not forget to check those cables as well to make sure they are 
seated correctly and are not worn from moving equipment around.  A little preventative action now 
will help ensure that your system is in top shape. 

 Are you encountering specific error messages? 
“I think it said something like . . .” may not be much help to people trying to identify what is wrong.  
Determine whether those errors are coming from your computer, DOS, Windows, or the 
chromatography software, and write down or make a screen print of exactly what the message 
says.  Each of these error messages should be described in the appropriate manuals supplied with 
your system or software; this description will help direct you to the problem.  
Chromera has a log directory that stores error messages encountered by Chromera.  Your 
Chromera Support Specialists may request that you send these log files for further analysis.  We 
recommend that you keep at least a week’s worth of these files on hand.  This will help us to 
determine if the system has a history of repeated error messages. 
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 Is the problem repeatable, or can it be duplicated on another system? 
Fundamental to solving software and hardware mysteries is knowing exactly when they occur and 
what the conditions are that lead to their occurrence. 
a) If you have multiple Chromera systems available, check whether the problem occurs on other 

systems as well.  If it does not, this may point to a system problem and will help focus the 
troubleshooting effort. 

b) Can the problem be duplicated with the test data files that came with the system?  If not, this 
may point to a problem with the new files you created. 

c) Are you on a network?  See if the problem still exists when you are disconnected from the 
network to rule out a network problem. 

Remember that system operation is dependent on everything communicating in harmony. In the 
case of data acquisition software, the timing and number of these communications are incredibly 
complex and demanding on the system, involving both internal (computer, disk drive, printer) and 
external (instrument control.  
Occasionally, something interferes with this communication and simply cannot be traced.  Perhaps it 
is the result of electrical disturbances in your lines from voltage brownouts or surges; a strong 
magnetic field created by equipment in the next lab; a loose connection; a failing piece of hardware; 
or just the night cleaning crew plugging their vacuum cleaners into the same circuit as the system 
analyzing your overnight run.  If the problem seems to have disappeared, make a note of it just in 
case, but you can generally proceed without concern.  

 What has changed since the problem started? 
“It was working fine yesterday. No one touched anything...really!” 
Software doesn’t just break.  Ask everyone who uses or maintains your system whether anything 
has been done to it that you do not know about.  

• Has someone installed a new software package or driver that might be interfering?   

• Has someone on the night shift altered the Chromera or Windows configuration file since you 
last operated the system? 

• Has someone changed my directory permissions? 

• Have my user and/or Chromera process account passwords expired?   

It is not impossible that a software file gets corrupted somehow, but before you reinstall the 
software, check out the obvious culprits first.  These can often be diagnosed quickly by rebooting 
your system with a blank system disk containing basic autoexec and config files.  If the problem 
disappears with the use of this system disk, look to the startup files for a potential conflict. 
Hardware on the other hand does break.  Even worse, it can break with an insidious style that 
drives users and support specialists crazy.  It can work fine one day and create havoc the next.  
Often we cannot catch this until it finally breaks for good.  Every system should have a good 
diagnostic software tool that puts its hardware through the paces so hardware faults can be 
determined or ruled out.  Do not forget the obvious here, or maybe not so obvious, too.  

• Did someone move equipment? If so are the cables seated properly?  

• Is your hard disk full?  

• Is your printer connected and turned on?  

• Did someone wrap that extra length of cable around the base of an old centrifuge to clean up 
the lab counter top? 

More than half of all the calls to Software Support have nothing to do with the actual Chromera 
software, but are the result of problems with Windows, network configuration, hardware system 
configuration, or device drivers for printers and other devices. 
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Internet Support Help 

Additional support information is provided on the PerkinElmer web site:  

http://las.perkinelmer.com/content/onesource/index.html 

This service provides an economical vehicle for users to get the latest information regarding product sup-
port issues. 

When All Else Fails and You Need Help 

If you tried all of the above and still need help or advice, it is time to contact us. PerkinElmer has several 
options in place for assistance with PerkinElmer software and hardware. Your local sales or service 
representative will provide you with information regarding how to access providers of assistance in your 
particular country. 

If your shipment contains a companion pamphlet covering software support options in your country, 
review that pamphlet to see what options are available to you BEFORE that first question or problem 
comes up. Keep this information along with user manuals, software media, and the license agreement in 
a safe, accessible location. 

Register for a User’s Class 

Most labs will have a few users that will quickly understand Chromera.  As the first month of Chromera 
implementation nears completion, arrange to have one or more users participate in a product-training 
course.  Do not sign up for the class before you have at least 30 days on the system.  Our technical 
trainers have seen new users take the class before the installation of Chromera, and they just do not 
have the experience with the software to get everything out of the class they would have if they had 
waited.  

In the U.S., you can request a Technical Training brochure, current schedule, or class registration by 
calling the For more training contact PerkinElmer at 1-800-762-4000 Option 4 to hear the available 
training options or visit PerkinElmer on the web at http://www.perkinelmer.com/Training. Outside the 
U.S., contact your PerkinElmer representative for local information. 

 

PerkinElmer Product Specialists 

The PerkinElmer field organization has a staff of highly skilled local specialists in GC, LC, and data 
handling products who are available for on-site assistance with any application need your lab might have.  
These specialists draw on many years of experience in laboratory environments just like yours.  If you 
would like to use these resources, feel free to contact your PerkinElmer sales staff. In the U.S., call the 
Sales Administration staff at 1-800-762-4000. 

http://las.perkinelmer.com/content/onesource/index.html
http://www.perkinelmer.com/Training
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Placing the Call . . . 

When you need to talk to a technical representative, the following list can help you get the most from 
that conversation. Like you, we want to resolve your call as quickly as possible. 

 Have the phone within reach of the system. 
We may have you try several things on your system to determine the source of your problem.  Or, 
we may have you go over the steps you are having problems with, keystroke by keystroke, as we 
duplicate them on the other side. 

 Have your Serial Number, Software Licenses and/or your original software media 
available. 
You will need these to access most centralized phone support programs and services. 

 Have your computer hardware, Windows, and software manuals available. 
We may need to refer you to these for additional information. 

 Know the version and service packs of all relevant software packages. 

 Record any error messages exactly as they appear on the system. 
Make sure you can state exactly where errors occurred and what steps are required to reproduce 
them. 

 Have available the make and model numbers of your computer and associated 
hardware. 

 Have the end user make the call. 

NOTE:  DO NOT make calls on behalf of the end user having the problem unless you fully understand both the 
problem and the system. These calls are seldom resolved quickly because of the unfamiliarity of the caller 
with the situation. 

Contacting PerkinElmer 

 US & Canada Customers Outside the US 

Customer Support Phone:  (800) 762-4000 Local PerkinElmer Sales Office 
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What Happens to My Problem or Suggestion? 

As problems and suggestions regarding software operation, functionality, features, or documentation are 
reported by registered users, Software Support begins a software investigation.  This investigation starts 
with a search for whether the issue has been previously reported. If it has, you will be notified of the 
resolution.  If a problem has not been reported, Software Support will attempt to duplicate your 
experience on standard supported computer systems sold by PerkinElmer. 

If the problem can be duplicated by Software Support, and it resides in our software, a Software Problem 
Report will be prepared and forwarded to the Product Department, as well as, Software Development for 
further action. 

What If My Problem Can’t Be Resolved Immediately? 

Occasionally, everything we do in a remote troubleshooting process comes up empty, and we need to do 
some research with the product, your system and data, our engineering staff, or a third party.  If we 
cannot reproduce the problem, we will assist you with as much user education, system configuration 
troubleshooting, and hardware troubleshooting as is possible from a remote location.  We will continue 
until the problem is resolved or until we can advise you what we think is necessary for it to be resolved. 

In cases where we cannot make the symptoms appear as described, we may need to get additional 
information from you regarding the system you are working on and its setup and configuration.  We may 
also need verification that the software is installed according to product documentation.  This process 
may require eliminating potentially interfering third party software or hardware in an effort to return the 
product to a functioning state.  Sometimes this can be a tedious process over the phone, and as Murphy’s 
Law dictates, this always seems to occur when you have to get those 200 samples out the door.  Please 
be patient.  You are our eyes, ears, and hands in these situations, and we need you.  

If the problem requires on-site assistance, or is the result of operation of the software on non-standard 
or non-supported hardware or system configurations, Software Support may make several suggestions.  
One may be to request you involve the local PerkinElmer Service office and get a service engineer on site 
who can help us evaluate the situation first hand.  Software Support will work with the local office to 
assist in the effort. 
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How to Import TotalChrom Data and Methods 

This exercise will demonstrate how to import TotalChrom data (TotalChrom Index Files Data, 
TotalChrom raw data, or TotalChrom component names from TotalChrom methods) provided that the 
RAW data files are in TotalChrom 6.3.x format.  

The component names are read into the Chromera Component Dictionary. The Component 
Dictionary is a typing aid used in the Chromera Method Editor, to allow component names to be 
assigned to peaks in a new method by selecting them from the dictionary, or by using the “auto 
complete” mode when typing a component name. This functions much like Microsoft Outlook when 
typing the name of a recipient into the To: or Cc: list for a new message. 

To Import TotalChrom Data and Methods: 

 From the Tools menu, select TotalChrom Data from the Import Menu. 

 

The Import Data Type screen appears: 

 
This initial page displays for you to select the type of TotalChrom data to be imported (TotalChrom 
Index Files Data, TotalChrom raw data, or TotalChrom component names) and select the source 
directory containing the TotalChrom files. 
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Import TotalChrom Index Data Files 

This option enables you to import a group of TotalChrom RAW data files by selecting the Index (IDX) file 
that points to them. This creates a corresponding Chromera Batch as a consequence. 

1. Select TotalChrom Index Files Data. 

 

2. Browse to a folder containing the TotalChrom Index files then click the Next button.  
Only the TotalChrom files in that specific folder will be displayed for importing. Subfolders of the 
current one will not be searched automatically.  

NOTE:  The Next button is not enabled until you select a directory containing files corresponding to the selected 
data type. For example, if you select TotalChrom Index Files Data, the directory must contain IDX files. 

The Data Selection screen appears: 
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The software reads each file in the selected directory with an .idx extension and determines if it is a 
valid TotalChrom IDX file. For the purposes of import into Chromera, "valid" means that its format is 
the latest TotalChrom IDX file revision. If the file is valid it is included in the upper pane display list. 
Also, a list of raw files for each idx is displayed in the lower pane (The view is same as seen in raw 
file import). The first row is selected and highlighted in the IDX file pane, and the first raw file is 
highlighted with its information and chromatogram displayed in the bottom two panes. 
 
If IDX files are highlighted in red it indicates a problem shown in the Status field … which may be 
scrolled out of sight. 

 

3. You can select one or more IDX files to read. All valid ones will be selected by default. 

4. You can select individual raw files from total available raw files for a select index file, by clicking in 
each check box for the desired raw files. 

NOTE: You can also select all / deselect all files of either type by clicking in the check box next to File Name in 
either the IDX or RAW file list panes.  This selects / deselects all valid index files and all corresponding 
valid raw files.  Also, selecting any raw file, and then clicking the Next button, will automatically select its 
corresponding IDX file. 

5. After selecting your desired Index and Raw files, click Next. 
The Review Batch Data screen appears, displaying the contents of the IDX file in the logical 
layout of the Batch that will be created.: 
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NOTE: When reviewing batch data from an index file, you can rename the batch name (for example, 
ChromeraTestSequence.idx) by right-clicking on it, selecting Rename Node, and typing a new name. 

6. Select from the tree display the individual files to import, or select the batch name (the .idx file 
name) to import all the data identified in that IDX file.  
Clicking on an entry in the list displays the chromatogram and sample information for that file. 

NOTE: The data files pointed to by the IDX file must be accessible to this computer if they are stored elsewhere, 
such as on a network drive or file server. 

7. Type a Group Name then click the Import button to load the selected data into the Chromera 
database as a new Batch, associated with the Group Name entered. 
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Import TotalChrom raw data Files 

This option enables you to import a group of TotalChrom RAW data files by selecting them directly from a 
folder. A corresponding Chromera Batch will be created as a consequence. 

1. Select TotalChrom raw data Files. 

 

2. Browse to a folder containing the TotalChrom raw data files then click the Next button.  
Only the TotalChrom files in that specific folder will be displayed for importing. Subfolders of the 
current one will not be searched automatically. 

NOTE:  The Next button will not be enabled until you select a directory containing files corresponding to the 
selected data type. For example, if you select TotalChrom raw data, the directory must contain raw files.  

The software reads each file in the selected directory with a .raw extension and determines if it is a 
valid TotalChrom raw file. For the purposes of import into Chromera, "valid" means that its format is 
the latest TotalChrom raw file revision. If the file is valid it is included in the display list.  

A progress bar on the bottom of the screen displays while files are examined. The progress is 
updated based on the percentage of raw files contained in the directory that have been examined. 
The Select All, Clear All and Back buttons are disabled during this process. When complete the 
Data Selection screen appears: 
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Select the individual files to import, or click Select All to import all the data shown in the list.  Only 
the TotalChrom RAW files from the specific folder will be displayed for importing. Subfolders of the 
current one will not be searched automatically.  Clicking on an entry in the list displays the 
chromatogram and sample information for that file. 

3. Click the Next button. 
The next step inspects the data to see which are valid for importing. Only data from TotalChrom 
6.3.x or newer can be imported directly. Any older files must be converted to a newer version 
through TotalChrom Batch Reprocess using “Update existing RAW file header” option.  

 
Any TotalChrom data not of a supported version, or otherwise not suitable for import, will be 
highlighted in red in the Batch Data list.  

4. Type a Group Name the click the Import button to load the selected data into the Chromera 
database as a new Batch, with the name of the TotalChrom sequence from which the RAW data 
were originally acquired. 
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Import TotalChrom component names 

This option enables you to populate the Chromera Component Dictionary with the complete list of 
component names read from all the TotalChrom methods found in a selected folder and subfolders. 

1. Select TotalChrom component names. 

 
To import component names from TotalChrom methods, browse to a folder that contains the MTH 
files to be read. Individual folders can be searched, or all the subfolders below the selected one can 
be searched as well by selecting Search subdirectories for methods. 

2. Browse to a folder containing the TotalChrom methods then click the Next button. 

NOTE:  The Next button will not be enabled until you select a directory containing files corresponding to the 
selected data type. For example, if you select TotalChrom component names, the directory must contain 
method files.  

The software reads each file in the selected directory with a .mth extension and determines if it is a 
valid TotalChrom method file. For the purposes of import into Chromera, "valid" means that its 
format is the latest TotalChrom method file revision. If the file is valid it is included in the display 
list. 

3. Click on the method name to highlight it and display the method’s components in the right pane. 

 
Highlight each method to see if it contains the components you want.  

4. If the method contains your desired components, click in a check box to select a method. 
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You can continue to highlight methods to see components and select methods that contain the 
components you want. 

5. After selecting the methods that contain your desired components, click Next. 
A list of components from all of the selected methods are displayed to be merged into the Chromera 
directory. 

 

6. Click the Import button to load the component names into the Component Dictionary. 
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Copying Component Information in Chromera Method Editor 

It is also possible to copy detailed component information from an individual TotalChrom method into the 
Chromera method editor, to populate the Peaks and Calibration sections of a Chromera method. 

1. Select the Actions menu.  Then select Copy Components > From TotalChrom Method. 

 
This function will copy not just component names, but also retention times, calibration information, 
and integration timed events to a selected Chromera data channel. 

 

2. In Copy from TotalChrom method browse for a method. 
Displays the source of the components to be copied. The field is populated by selecting 
a file from a standard File Open dialog displayed when the browse button is clicked. 
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3. In Copy to channel select the checkbox to set the Chromera method data channel(s) the 
components will be copied to. The list is populated with all data channels from the method. You can 
copy the components to more than one channel by selecting the required channels within this 
control. 

 Select to Include Integration Events to copy the integration events from the TotalChrom 
method to the destination channel. 

 Select Include Calibration Standards to copy the calibration standard amounts with the 
other component information. 

4. The display at the bottom lists the components found in the TotalChrom method, together with their 
retention times. 

5. Click OK to copy the components. 
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